Lecture 5:  Survey Nitty Gritty
Sampling Using SPSS

I.  Sampling without replacement from a population of cases or sampling frame.
A.  Enter the sampling frame (aka the population of cases) into the SPSS data window.  This is the list of unique identifiers of the elements of the population.  Often this will be simply the list of numbers from 1 to N, the number of persons in the population.  (See III for how to put the integers from 1 to N in the data editor.)
B. Data -> Select Cases…
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C.  Respond to the following dialog box.

[image: image14.wmf]Percentage of “Very Much 

Time” Responses

Recruitment

Selection

EEOC Issues

Benefits exc. Insurance

Training

Compensation

Insurance

OSHA/Safety

40

30

20

10

0

Percentage of “Very Much 

Time” Responses

Recruitment

Selection

EEOC Issues

Benefits exc. Insurance

Training

Compensation

Insurance

OSHA/Safety

40

30

20

10

0

[image: image1.png]Select Cases

- Selct

© Allcases
© Ifcandion s saisied

[

& Random sample o cases

Sample.
" Based on fime or case range

Fenge
 Use it varable:

]

-Unselected Cases Are.
& Fitered  Deleted

Cuent Status: Do ot fite cases

0k | Poste | Reset | Concel | Hep

— CEETETT—
- wl x|

6| [ Semple Size
18 |~ c
T | oy [ % arolcoes
=  Eroch 20 oasesomthefist [2000  coes,

» [\Dsta v

Carel |t





D.  Analyze -> Summarize.

Have SPSS list the cases.  Only those selected will be listed.

E.  To reactivate all cases, Data -> Select Cases….

Check the All Cases box.

II.  Randomly Ordering All Cases.

A.  Put whatever list you want to order, e.g., the sampling frame, in the data editor window.

B.  Transform -> Compute….

C.  Put the name of a variable in the “Target Variable” field.  Choose RV.NORMAL(0,1)
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D.  Data -> Sort Cases.  Sort on RANDOMS, the variable just created.
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E.  Analyze -> Summarize

Have SPSS list the cases.  The order in which they'll be listed will be random.

Note that this ordering can be the basis for sampling without replacement.

III.  Putting the integers from 1 to N into the data editor window.

A.  File -> New -> Syntax.

This creates a new window called a Syntax Window.  SPSS commands (called Syntax) can be put into that window and executed.

B.  Enter the following into the syntax window.


input program.
loop #i=1 to 10000.
compute id = $casenum.
end case.
end loop.
end file.
end input program.
execute.
print formats id (f8.0).
C.  In the syntax window, Run -> All.

This tells SPSS to execute the above commands.  The result will be the successive integers from 1 to whatever N you put in the second line in a column called ID.

Defining Data in a Syntax Window 

Six Important Commands


1.  DATA LIST  (A required command.)
Used to

a)  tell SPSS the names of variables

b)  tell SPSS where the variables are located

c)  tell SPSS the type of variable

d)  other, less important things

Short example

DATA LIST FREE / q1 q2 q3 q4 q5 gender age educ.

2.  VARIABLE LABELS  (An optional command.)
Used to give extended labels to variables.

Short example

VARIABLE LABELS q1 “I feel good about my job”

 q2 “I am comfortable with my supervisor”

 q3 “I am satisfied with my pay”

 q4 “I look forward to coming to work each day”

 Age “Age in years at least birthday”

 Educ “Last year of formal education completed”.

3.  VALUE LABELS (An optional command.)
Used to give labels to values of categorical variables.

Short example

VALUE LABELS q1 to q4 1 “Strongly disagree” 2 “Disagree” 3 “Neutral”

 4 “Agree” 5 “Strongly Agree”

 / gender 1 “Female” 2 “Male”

 / educ 1 “HS” 2 “Some college or trade school” 3 “Graduate degree”.


4.  MISSING VALUES  (An  optional command.)
Used to tell SPSS about values which are to be treated as missing.

Short example

MISSING VALUES q1 to q4 (9) gender (9) age (999) educ (99) 
5.  BEGIN DATA.  (A required command.)
Immediately precedes data.

6.  END DATA.  (A required command.)
Immediately follows data.

1.  Example of syntax files used to enter data.


DATA LIST FIXED / q1 1 q2 2 q3 3 q4 4 q5 5 q6 6 age 7-8 gender 9 (a) educ 10.

VARIABLE LABELS q1 “I like my job”

 Q2 “I have fun on my job”

 Q3 “My job is a gas”

 Q4 “I hate to go home from my job”

 Q5 “My job is wonderful”

 Q6 “I wouldn’t trade my job for the world”.

VALUE LABELS  

 q1 to q6 1 “Strongly disagree” 2 “Disagree” 3 “Neutral” 4 “Agree” 5 “Strongly Agree”.

VALUE LABELS educ 1 “HS” 2 “Some college” 3 “College degree” 4 “Some post bac” 5 “Post bac degree”.

MISSING VALUES q1 (9) q2 (9) q3 (9) q4 (9) q5 (9) q6 (9) age (99) gender (‘?’) educ(9).

BEGIN DATA.
121212 7F1

45444424M3

33333372F1

. . .

21232165M2

END DATA.
2.  Same Example using the “to” convention to group variable names.

DATA LIST FIXED / q1 to q6 1-6  age 7-8 gender 9 (a) educ 10.

VARIABLE LABELS q1 “I like my job”

 Q2 “I have fun on my job”

 Q3 “My job is a gas”

 Q4 “I hate to go home from my job”

 Q5 “My job is wonderful”

 Q6 “I wouldn’t trade my job for the world”.

VALUE LABELS  

 q1 to q6 1 “Strongly disagree” 2 “Disagree” 3 “Neutral” 4 “Agree” 5 “Strongly Agree”

 /educ 1 “HS” 2 “Some college” 3 “College degree” 4 “Some post bac” 5 “Post bac degree”.

MISSING VALUES q1 to q6 (9) age (99) gender (“?”) educ (9).

BEGIN DATA.

121212 7F1

45444424M3

33333372F1

. . .

21232165M2

END DATA.



Some real life syntax files.

1.  Example 1.  Survey of kids on proximity to firearms.

data list fixed /id 1-3 q1 to q9 4-12 age 13-14 ses 15 survey 16.

variable labels q1 "Have you ever seen someone else HOLDING a gun?"

 q2 "Have you ever seen someone else FIRING a gun?"

 q3 "Have you ever seen someone else BEING SHOT or SHOT AT?"

 q4 "Have you ever HELD or TOUCHED a gun?"

 q5 "Have you ever FIRED or SHOT a gun?"

 q6 "Have you ever BEEN SHOT or BEEN SHOT AT by a gun?"

 q7 "Does anyone that you live with OWN A GUN?"

 q8 "Do you visit homes of people that OWN A GUN?"

 q9 "Does anyone in your home GO HUNTING?".

value labels q1 to q8 1 "Yes" 0 "No"

 /survey 1 "Survey B" 2 "Survey A".

missing values q1 to q9 (9) age (0) ses (6).

begin data.

0011101101191711

0021101101191811

0030001000191511

0541101101191341

0551001000191641

0560001001191741

0571110000191541

0581100000191641

0591111101191841

0601111011191841

0611101101191641

0621101100191841

0631111111191541

0641101101191841

0651111101191841

. . .

1081101101110052

1091111101110052

end data.

Example 2.  Entry of  Big Five questionnaire data.

Data are entered as they occur on the questionnaire:  eacsoeacsoeacsoeacso . . .

In the following, the C responses are in red in line 1.

data list fixed /id 1-3 q1 to q50 4-53.

begin data.

50532655451534165456154327254513322736661352574664634

50622343646524266466374431656466213555644512525576563

50742544473524464645332455352423252545542444553655546

50851655465436356635442634462543242654563465465474545

52542433464524253546262423461632251435263236652666515

51042554461356356446334626354624352645553434564646555

50931647471214175746251316364622121726561262762776727

52421665462436176546243525454724232645462124554546735

52341535271636376526161626352611161726352345364546415

52142654342344265443244525543535443644436534365343645

51944625361626563533252552263423335727542154373745636

52072664263326267525272633462545262646352336575436627

51723776661244376564235423566426212765753651566774656

51841544362637354557353616363714251635652244662545524

51646555362646254636364546452623262425463236633626626

51462417273727262526151614461631262436461166642627536

51332376364333426456445533743546353445445453426665344

51241646171347266625244624461424171745261166574626627

51142535362545255345264525244322442525454144562535415

52242626254513165536251644262423263636451354573744746

50442667377234276547253522661773251665571465766777626

50342635452635363746262223375632122626664233632776527

50252525456624464546351432252442242436442145542645515

50141565452325266646251524553623262634452344653536535

51511621661524164257271326245322621725661216661557713

52632646573422175656231355465534213646642464564656657

end data.

Example 3.  Syntax to process the data from Example 2.

Note:  Lines beginning with **** are comment lines.

**** Create e1 e2 . . . o9 o10 and reverse-score appropriate items.

recode q1,q6,q11,q16,q21,q26,q31,q36,q41,q46 (1=1)(else=copy) 

into e1 e2 e3 e4 e5 e6 e7 e8 e9 e10.

recode q2,q7,q12,q17,q22,q27,q32,q37,q42,q47 (1=1)(else=copy) 

into a1 a2 a3 a4 a5 a6 a7 a8 a9 a10.

recode q3,q8,q13,q18,q23,q28,q33,q38,q43,q48 (1=1)(else=copy) 

into c1 c2 c3 c4 c5 c6 c7 c8 c9 c10.

recode q4,q9,q14,q19,q24,q29,q34,q39,q44,q49 (1=1)(else=copy) 

into s1 s2 s3 s4 s5 s6 s7 s8 s9 s10.

recode q5,q10,q15,q20,q25,q30,q35,q40,q45,q50 (1=1)(else=copy) 

into o1 o2 o3 o4 o5 o6 o7 o8 o9 o10.
**** Reverse score the negatively worded items.

recode e2,e4,e6,e8,e10, a1,a3,a5,a7, c2,c4,c6,c8, s1,s3,s5,s6,s7,s8,s9,s10, o2,o4,o6

 (1=7)(2=6)(3=5)(4=4)(5=3)(6=2)(7=1).

print formata e1 to o10 (f2.0).

variable width e1 to o10 (3).

execute.
Example 4.  Example using FREE field data.
FREE field data must have a space or comma between each value within a line of data.

DATA LIST FREE / q1 to q6  age  gender (a) educ .

VARIABLE LABELS q1 “I like my job”

 Q2 “I have fun on my job”

 Q3 “My job is a gas”

 Q4 “I hate to go home from my job”

 Q5 “My job is wonderful”

 Q6 “I wouldn’t trade my job for the world”.

VALUE LABELS  

 q1 to q6 1 “Strongly disagree” 2 “Disagree” 3 “Neutral” 4 “Agree” 5 “Strongly Agree”

 /educ 1 “HS” 2 “Some college” 3 “College degree” 4 “Some post bac” 5 “Post bac degree”.

MISSING VALUES q1 to q6 (9) age (99) gender (“?”) educ (9).

BEGIN DATA.

1 2 1 2 1 2 7 F 1

4 5 4 4 4 4 24 M 3

3 3 3 3 3 3 72 F 1

. . .

2 1 2 3 2 1 65 M 2

END DATA.

 Dealing with open-ended Questions

Example

“What is the most important problem facing our city?”
Responses range from 1 word to a paragraph.

Such responses are often categorized and the categories analyzed.

Three strategies

1.  Enter the responses verbatim into SPSS’s Data Editor window.

A.  Use FREQUENCIES to list all the responses.

B.  Categorize each response.

C.  Enter the response category into a column next to each response.

e.g.
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2.  Enter verbatim responses and IDs into a table in Word.

Categorize in Word.

Enter the categories into the SPSS Data Editor.

	Id
	Category
	response

	1
	
	I think the worst problem is crime.

	2
	
	It’s the war.

	3
	
	


3.  Categorize the responses “on the fly” while doing data entry and enter the categories in SPSS.
A.  Go through the original survey response forms.

B.  Write the response category next to the written response.

C.  Enter the response categories into SPSS as you’re entering the rest of the data.
Example of the first procedure

We asked respondents to enter their job titles.  Following are the verbatim responses from the SPSS FREQUENCIES procedure.
Administrative & Engineering Man
Administrative Assistant
administrator of human resources
Assistant HR Manager
Branch Manager
Change Management/Mgt. Developme
Corp. HR Coordinator
Corporate Director HR 
Corporate HR Manager
Corporate Human Resources Manage
Director Employment & Recruitmen
director of HR/EEO
director of human resources 
Director Org Dev & Education
Emplloyment Coordinator 
Employee Relations Manager
Employee Relations Supervisor 
Employment Coordinator
Employment Services Coordinator 
Executive Consultant
executive vice president
HR
HR Business Consultant
HR Consultant 
HR Coordinator
HR Director 
HR Generalist 
HR Manager
HR Mgr
HR Rep
HR Specialist 
HRIS Consultant 
HRM 
Human Resouces Director 
Human Resouces Manager
human resource director 
Human Resource Generalist 
human resource manager
Human Resource Manager
Human Resource Mgr
human resources manager 
Human Resources Manager 

Law and HR Associate
Management Consultant 
Manager-Administration & HR 
Manager-EmpRelat&SR.HRConsultant
Manager Human Resources 
Manager, People Services
Mgr - Empl Rel/Sr HR Bus Consur 
MGR, HR 
owner 
Owner, Staffing Service 
Personnel Asst. 

president and managing partner
Professor 
Recruiter/Job Specialist
Relocation Director 
Retirement Benefits Coordinator 
Safety&Technical Training Superv
Sales & Recruiting Manager
Sales Manager 
staffing and trianing director
Staffing Specialist 
Training and Support Coordinator
Vice president - human resources
Vice President Human Resources
VP Employee Relations 
VP of Human Services
Workdeys Development - HR 

We categorized each title as 

1 - involving/mentioning  HR or 

2 - not primarily involving/mentioning HR.

Presenting Results of Surveys

1.  Simple Frequency Distributions

Frequency distributions are the most often used results display.  A set of frequency distributions for all variables is almost always included.

A.  Sometimes it’s best to make the tables up in a word processor, such as the following.

Section A. Information about respondents

1.  What is your job title?

Over 50 different job titles were listed by respondents.  For the purpose of this report, they were grouped into two categories - those in which HR was specifically mentioned and those in which there was no specific mention of HR.

	Job Category
	No. Respondents

	HR Mentioned
	65

	HR Not mentioned?
	27


2.  What is your age?

	Age group
	No. Respondents

	20-29
	10

	30-39
	20

	40-49
	30

	50-59
	26

	60-69
	5

	No response`
	1


3.  What is your gender?

	Gender
	No. Respondents

	Male
	40

	Female
	52


4.  What is your race?

	Race
	No. Respondents

	American Indian/Alaskan Native
	1

	African American
	7

	White
	82

	Hispanic / Latino
	1

	No response
	1



5.  For how many years have you worked in your present organization? 

	No. Years
	No. Respondents

	0-4
	43

	5-9
	22

	10-14
	7

	15-19
	3

	20-24
	7

	25-29
	6

	30-34
	1

	No response
	3


6.  For how many years have you worked in HR?

	No. Years
	No. Respondents

	0-4
	21

	5-9
	25

	10-14
	15

	15-19
	14

	20-24
	8

	25-29
	4

	30-34
	2

	35-39
	2

	No response
	1


7.  In how many different organizations have you worked as an HR professional?

	No. Organizations
	No. Respondents

	0
	3

	1
	30

	2
	27

	3
	11

	4
	14

	5
	4

	6
	0

	7
	2

	No response
	1


Example 2 from a recent survey of residents of Fort Wood.
Fort Wood Neighborhood Association

Traffic Flow and Parking Survey

1.  
Currently in certain parts of our neighborhood, the 800 blocks of Oak, Vine and Fortwood Streets, and the 500 block of Fortwood Place, those persons without a Fort Wood decal can only park on the street for one (1) hour, on Monday through Friday, from 7:00 a.m. to 6:00 p.m. Residents in those areas who want to park on the street beyond the aforementioned limits must purchase a parking decal issued by the city. This ordinance was implemented years ago to minimize parking congestion from non-residents. Some residents think the present system is not effective due to increased UTC enrollment and the difficulty of enforcement of the ordinance.  Cost of a decal has increased from $6.00 to $25.00 and will now be issued as a bumper sticker.

Please check the line that would more appropriately reflect your opinion.




 800
900/1000
All Respondents

Block
Block

N = 166


N=78
N=79
  # 
    %
    
  %
  %

28
17.5
_____
15.4
21.5
a. Leave current ordinance concerning parking as is.

  7
  4.2
_____
  6.4
  1.3
b. Eliminate the parking ordinance all together and have no 





restrictions.

35
21.1
_____
12.8
31.6
c. Extend the current ordinance to all Fort Wood streets.

98
59.0
_____
65.4
51.9
d. Modify the ordinance to not allow on street parking unless you are a Fort Wood homeowner, business owner, renter, or reside in a home in Fort Wood but do not pay rent and have purchased a decal or are a guest of one of the above and have obtained a temporary permit to park and extend this policy to all of the Fort Wood area.

76
45.8
_____
50.0
43.0
e. Add option to tow all unauthorized vehicles.

14
  8.4
_____
  9.0
  6.3
f. Other.  (Please explain in the space below or on another sheet.)

The sum of the number of checked alternatives exceeds 166 because some respondents checked multiple alternatives.  There were 258 check marks in all.

An address was not available for 9 respondents.

122 (73.5%) of the respondents checked Q1c or Q1d or both.  So 73.5% of the respondents favored extending the ordinance to all of Fort Wood, either without change (c) or restricting parking completely (d).

59 (75.6%) of those in the 800 block checked Q1c or Q1d or both .
57 (73.1%) of those in the 900/1000 block checked Q1c or Q1d or both.
__________________________________________________________________________________

B.  Sometimes you can use raw SPSS FREQUENCIES output.

The FREQUENCIES procedure automatically includes a “Valid Percent” column and a “Cumulative Percent” column, both of which may be confusing or inappropriate.  If you use such output, you should include an explanation of what those two columns mean, such as the box below.

Frequency Distributions on all variables
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2.  Crosstabulations of categorical dependent variables by categorical independent variables.

A.  Crosstabulations using the CROSSTABS procedure.

The next step beyond simple frequency distributions is examination of percentages of responses to a categorical dependent variable across groups defined by an independent variable.

The SPSS CROSSTABS procedure is ideal for this.  

Example – Were there differences in preferences for making Vine St. two way from respondents living on different blocks of Vine St.
	vinepref * block Crosstabulation

	
	block
	Total

	
	1 800
	2 900
	

	vinepref
	.00 No preference
	Count
	2
	1
	3

	
	
	% within block
	6.3%
	2.6%
	4.2%

	
	1.00 Remain oneway
	Count
	26
	30
	56

	
	
	% within block
	81.3%
	76.9%
	78.9%

	
	2.00 Become twoway
	Count
	4
	8
	12

	
	
	% within block
	12.5%
	20.5%
	16.9%

	Total
	Count
	32
	39
	71

	
	% within block
	100.0%
	100.0%
	100.0%


There was a striking consensus of Fort Wood residents on Vine St. that it remain one way.
B.  Stub and Banner Tables – Crosstabulations with multiple independent variables.

Oftentimes, survey researchers pick a dependent variable, then display crosstabulations of it across groups defined by several independent variables.  Typically, these independent variables are basic demographics – gender, ethnic group, age group, etc.  Such tables are called Stub and Banner or Banner Tables.  Typically, the categories of the dependent variable are put across the columns of the table, and the various independent variables and their categories down the rows of the table.

Example
Table 4

Evaluation of City Job Done Providing Job Opportunities

                                                                       Don't

                                       Excellent Good   Fair   Poor    Know     N

All Respondents                             3.3   30.5   33.2   24.0    9.0    600

------------------------                     .      .      .      .      .       .

South of Downtown                           4.5   20.5   38.6   29.5    6.8     44

Downtown/East                                .9   19.3   38.5   33.0    8.3    109

North of River                              5.2   38.1   30.9   15.5   10.3     97

------------------------                     .      .      .      .      .       .

Downtown                                    3.6   36.4   40.0   18.2    1.8    110

Inner Ring                                  1.5   33.8   35.4   29.2     .0     65

Middle Ring                                 5.6   24.1   46.3   22.2    1.9     54

Outer Ring                                  6.0   26.9   40.3   23.9    3.0     67

Suburban Communities                        2.4   23.8   33.3   35.7    4.8     42

Other                                        .0   35.6   20.0   33.3   11.1     45

------------------------                     .      .      .      .      .       .

White                                       3.7   38.3   32.2   15.3   10.6    379

African American                            2.9   17.2   34.9   39.2    5.7    209

------------------------                     .      .      .      .      .       .

Female                                      4.3   28.9   32.9   24.6    9.3    301

Male                                        2.3   32.1   33.4   23.4    8.7    299

------------------------                     .      .      .      .      .       .

18-29                                       2.8   26.2   42.1   25.2    3.7    107

30-64                                       3.8   31.0   33.8   26.7    4.8    397

65+                                         2.1   33.3   20.8   11.5   32.3     96

------------------------                     .      .      .      .      .       .

LT 12 Years                                 2.8   24.5   19.8   36.8   16.0    106

HS Graduate                                 3.2   26.9   37.1   24.7    8.1    186

Some College                                4.1   28.9   36.4   20.7    9.9    121

College Grad +                              3.3   38.6   34.2   18.5    5.4    184

------------------------                     .      .      .      .      .       .

Working                                     3.4   31.5   37.0   25.1    3.1    387

Not Working                                 3.3   28.8   25.9   22.2   19.8    212

------------------------                     .      .      .      .      .       .

Rider                                       3.3   22.4   34.2   32.2    7.9    152

Non-rider                                   3.4   33.4   32.5   21.3    9.4    446

Stub and Banner tables can be created by performing several CROSSTABS involving the selected dependent variable with several independent variables.  For example,
.

[image: image8.wmf]Q1  Location of respondent's residence * Q11  Effect of new subdivisions begun in last 10 years on

county's scenic beauty, tree cover, and health of its natural environment Crosstabulation

% within Q1  Location of respondent's residence

14.1%

51.7%

34.2%

100.0%

20.7%

44.8%

34.5%

100.0%

24.2%

41.4%

34.3%

100.0%

18.6%

47.1%

34.3%

100.0%

a   Walker County not

inside any city

b   City in Walker County

c   Outside Walker

County

Q1  Location of

respondent's

residence

Total

a   Improved it

b   Damaged it

c   No significant

change

Q11  Effect of new subdivisions begun in last 10

years on county's scenic beauty, tree cover, and

health of its natural environment

Total


[image: image9.wmf]Q3  Respondent's age group * Q11  Effect of new subdivisions begun in last 10 years on

county's scenic beauty, tree cover, and health of its natural environment Crosstabulation

% within Q3  Respondent's age group

26.1%

56.5%

17.4%

100.0%

18.9%

45.9%

35.1%

100.0%

20.7%

44.8%

34.5%

100.0%

19.6%

46.6%

33.8%

100.0%

a   Over 65

b   31-64

c   Below

30

Q3  Respondent's

age group

Total

a   Improved it

b   Damaged it

c   No significant

change

Q11  Effect of new subdivisions begun in last 10

years on county's scenic beauty, tree cover, and

health of its natural environment

Total


[image: image10.wmf]Q7  Whether respondent owns a business in Walker County * Q11  Effect of new subdivisions begun

in last 10 years on county's scenic beauty, tree cover, and health of its natural environment

Crosstabulation

% within Q7  Whether respondent owns a business in Walker County

23.8%

47.6%

28.6%

100.0%

19.0%

46.3%

34.7%

100.0%

19.7%

46.5%

33.9%

100.0%

a   Yes

b   No

Q7  Whether respondent owns

a business in Walker County

Total

a   Improved it

b   Damaged it

c   No significant

change

Q11  Effect of new subdivisions begun in last 10

years on county's scenic beauty, tree cover, and

health of its natural environment

Total


[image: image11.wmf]Q8  Whether respondent owns land in Walker County * Q11  Effect of new subdivisions begun in last

10 years on county's scenic beauty, tree cover, and health of its natural environment

Crosstabulation

% within Q8  Whether respondent owns land in Walker County

16.9%

49.2%

33.8%

100.0%

24.3%

42.6%

33.0%

100.0%

19.7%

46.8%

33.5%

100.0%

a   Yes

b   No

Q8  Whether respondent owns

land in Walker County

Total

a   Improved it

b   Damaged it

c   No significant

change

Q11  Effect of new subdivisions begun in last 10

years on county's scenic beauty, tree cover, and

health of its natural environment

Total


Unfortunately, there is no easy way to make the stub and banner table within SPSS, and you’ll probably have to create it in Word by hand.

A second “hand-made” stub and banner table.

The following was created as a result of a citywide poll of TN residents prior to the November elections of 2002.  It was created in SPSS using a syntax commands and a procedure called AGGREGATE.

MOST ACCEPTABLE TAX REFORM OPTIONS

                                        Flat   Grad’d          

                                Sales   Inc    Inc    Prop   Don’t

                                 Tax    Tax    Tax    Tax    Know     N

All Respondents                  14.1   22.0   35.1    8.6   20.3    291

-----------------------------      .      .      .      .      .       .

Male                             16.8   22.6   35.8    8.8   16.1    137

Female                           11.7   21.4   34.4    8.4   24.0    154

-----------------------------      .      .      .      .      .       .

White                            12.8   23.3   37.9    5.7   20.3    227

African-American                 20.8   17.0   18.9   22.6   20.8     53

Other                             9.1   18.2   54.5     .0   18.2     11

-----------------------------      .      .      .      .      .       .

HS Graduate or Less              20.8    9.7   18.1   15.3   36.1     72

Some College                     18.9   28.3   18.9    7.5   26.4     53

College Graduate                  9.9   22.8   46.5    7.9   12.9    101

Post-Graduate                     9.5   30.2   50.8    3.2    6.3     63

-----------------------------      .      .      .      .      .       .

18 to 34                         14.9   10.6   40.4   19.1   14.9     47

35 to 44                         13.3   20.0   35.6    4.4   26.7     45

45 to 54                         15.6   28.6   37.7    5.2   13.0     77

55 to 64                         12.2   26.8   31.7    7.3   22.0     41

65 and over                      13.6   21.0   30.9    8.6   25.9     81

-----------------------------      .      .      .      .      .       .

Less than $25,000                13.6   10.2   32.2   15.3   28.8     59

$25,000 to $49,999               11.8   20.6   38.2   14.7   14.7     68

$50,000-$100,000                 10.8   31.3   37.3    2.4   18.1     83

Over $100,000                    20.0   24.4   33.3    6.7   15.6     45

-----------------------------      .      .      .      .      .       .

Union Household                  15.2   15.2   32.6    8.7   28.3     46

Non-Union Household              14.0   23.0   35.8    8.2   18.9    243

3. Presenting groups of similar items.

Some questionnaires contain groups of similar items.  The SHRM survey contained a question asking respondents to indicate the amount of time spent in each of 8 HR functions.  Presentation of such items is usually facilitated by imposing an order on the collective responses.  In the case of the report to SHRM, the raw percentages were presented as a collection of frequency distributions, one for each function.   In addition, a bar graph of the percentages of “Very much time” was created.  Both the ordering of the rows of the table and the ordering of the bars of the graph were in terms of the percentage of responses of “Very much time”.  This ordering permits respondents to see quickly which functions people spent a lot of time in (Recruitment, Selection) and which function respondents spent little time in (Insurance, OSHA/Safety).


B.  Please tell us about your responsibilities by indicating how much of your time is spent on the following HR functions?  

	Your responsibilities*
	Very little time
	Moderate amount
	Very much time
	No

response

	Recruitment
	30
	35
	28
	7

	Selection
	36
	33
	27
	4

	EEOC issues
	43
	32
	17
	8

	Training
	35
	46
	16
	3

	Benefits not including insurance
	44
	36
	15
	5

	Compensation
	41
	38
	12
	9

	Insurance
	42
	39
	10
	9

	OSHA/Safety issues
	62
	22
	8
	8

	Other 
	5
	6
	17
	72


* Entries are percentages of 92 respondents.

  Areas are listed in order of “Very much time spent” percentages.


Groups of similar items continued

Here’s another example, from the Walker County Survey.  The respondents were asked to circle features that developers should “design around” in new subdivisions in Walker County.  The proportion of times each item was circled is presented in the following table, again ordered from the largest proportion at the top to the smallest at the bottom.


These are the responses to Q13 items ordered by proportion of respondents circling the item.
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The result.





All of the cases in the data editor window  are "crossed out” except the requested number of cases.  





�





Replace the 1000 with whatever N is appropriate for your problem.





Tells SPSS that the values to follow will have spaces between them.





Names the variables.





Variable names can be upper or lower case.





Note that each new variable name must be preceded by a /.





(a) is used to identify a variable whose values are characters rather than numbers..





Note - The boxes around q1 to q6 are there to point them out to you.  They’re not part of the syntax.





“Fixed” tells SPSS that the data are in predetermined, fixed columns.  You have to specify which columns each variable is in after the variable name.





Valid Percent is percent of those respondents who actually answered the question.  If there are no missing responses for a question, Percent and Valid Percent will be identical.





You may choose to “white out” the Valid Percent columns.





Single DV





Multiple IVs





Make sure that %s sum to 100% within each Independent Variable category.
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